
 
The Wind View User Guide 

 
Wind View was created by AWS Truewind, LLC to allow users to view and query wind data in an interactive 
environment, as well as modify, copy, and print maps. This CD contains an ArcGIS published map file (.pmf), 
related spatial data, and other associated files necessary to view the interactive map using ArcReader software.  
The CD also contains files not used by ArcReader including static image files (such as JPEG or PDF) of various 
wind resource maps.  The spatial data used by ArcReader can also be imported by various GIS software 
packages.  
 
ArcReader is a free program created by the Environmental System Research Institute (ESRI, Inc) to allow for 
the sharing and distribution of dynamic maps created using ArcGIS.  ArcReader allows users to open the .pmf 
files, view and query a wide variety of spatial data in an interactive environment, print and copy maps.  To 
download the stand-alone version of ArcReader on this disk, see the instructions below.  For other instructions 
on using the software see the ArcReader Help menu, or visit the ArcReader section of the ESRI website at: 
http://www.esri.com/software/arcgis/arcreader/index.html.  
 
Installing the ArcReader Software 
 
System Requirements and Installation 
 
The first step is to install the ArcReader software on your system.  According to ESRI, ArcReader 9.0 will work 
on a PC-Intel system with Windows NT 4.0 service pack 6a, Windows 2000 or Windows XP operating systems.  
It will not work on Windows ME, 98 or earlier.  Due to the relatively large amount of data used in the program, 
it is also required that the system have at least a 450 MHz processor and a minimum of 128 MB of RAM.  The 
program will take up 100 MB of disk space on the system’s hard drive. 
  
To download the ArcReader software on this disk, you may either select “Click here to install the ArcReader 
software” from the startup Index.htm page, or navigate to the ArcReaderSoftware directory on the CD.  From 
the ‘ArcReaderSoftware’ directory, double click on the setup.exe file and follow the program instructions.  
 
NOTE:  You will not be able to install this software on your system if it currently has ArcGIS software 
installed.  If you attempt to add the software you will get an error indicating that existing ArcGIS software has 
been detected and the setup program will close out.  In this situation it is mostly likely that a compatible version 
of ArcReader is already installed.  However, if an older version of ArcReader is installed you will need to 
uninstall that version and download the new version included on this disk. 
 
Downloading the ArcReader Project Files 
 
Data Download 
 
The ArcReader project files have been formatted to a self-extracting (.exe) zip file in order to maintain the data 
paths that are essential for the integrity of Wind View.   
 
To download the data from the Index.htm startup page simply choose “Click here to download the Wind View 
project files” (please be patient, it may take several moments before the pop-up window will appear).  From the 
pop-up window you may choose to either save the .exe file or open it directly.   Select the option to “Open” the 
file.  Another pop-up window will appear that will prompt you to unzip the files to their proper location (again, 
this may take a few moments).  NOTE:  The default unzip location is C:/AWSTruewind/<Study Area>.  You 

http://www.esri.com/software/arcgis/arcreader/index.html


 
may choose a new location from the browse button, however in order to open the ArcReader project from the 
opening web browser interface, you must select the default location. 
 
If you wish to download the data from the CD and bypass the web browser interface, navigate to your CD drive 
and double click on the .exe file.  Click “Unzip” to download the files to the files to the default location (use the 
browse button to change the directory). 
 
Using the ArcReader Project 
 
Opening the Project 
 
Start ArcReader either by clicking on “Click here to execute the ArcReader project” from the Index.htm web 
page (assuming your files were placed in the default directory location), or go to the Start menu and select Start 
>>Programs >>ArcGIS >> ArcReader.  The program should open and be ready to load the .pmf file. 
 
To open Wind View from a blank ArcReader project, go to the File menu and click Open.  Navigate to the 
directory where the files were placed and then choose the file in the root directory with a .pmf extension.  
Highlight the file and click Open.   NOTE: The files may take several minutes to load. 
 
The ArcReader Layout 
 
 

  

5 

3 4

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

1
2
6



 
The ArcReader working environment contains a (1) Map Window, (2) Table of Contents (3) Menu, (4) Toolbar, 
(5) Refresh Button, Layout View/Data View Toggle, and (6) Coordinate Window.  For more detailed 
information regarding the parts of ArcReader see the tutorial on the ArcReader installation disk. 
Navigating ArcReader 

 
The Map Window, Table of Contents and Toolbar will be the main components necessary for viewing and 
querying data in the Wind View.   
 
Map Window 
 
When the project is first loaded the map window will open with a printable map including a title, scale bars, 
north arrow, logos, and legend.  This screen is also known as the ‘Layout View’.  If you wish to modify, view, 
or print your map in absence of these features you can click on the ‘Data View’ button (globe) near the Refresh 
button as indicated by  ‘The ArcReader Layout’.  We recommend the ‘Data View’ for most of your data queries 
and viewing purposes.  The button in between the globe and refresh buttons will allow you to return back to the 
Layout View. 
 
Table of Contents 
 
The Table of Contents lists and displays the symbology for each map feature (layer).  Directly to the left of the 
name for each layer is a small box that will either contain a checkmark, be blank, or grayed-out.  The 
checkmark indicates the layer is turned on and is active in the map window; it will be visible unless covered by 
another layer (note that only one layer displaying wind resource and/or elevation/land cover data will be visible 
at a time).  The layers with grayed-out checkmarks have a scale threshold set for viewing and are cannot be 
toggled on/off until they are at the appropriate scale.  To determine the set threshold, right click on the layer 
name and select the general tab.  The layers without a checkmark are not active and thus not visible in the map 
window. Click the empty box to make these layers visible. 
 
If you wish to show or hide the symbology for a specific layer, click in the box to the left of the active layers 
checkmark box.  A plus sign indicates that the layer’s symbology is hidden whereas a minus sign indicates the 
symbology for the layer is visible. 

 

 
Map Layers: 

• Annual Wind Rose Data / Image Hyperlink:  This layer becomes visible at a scale of 1:500,000 or 
greater.  All of the points have tabular data associated with them and can be viewed using the 
identify tool.  Only the blue points have Wind Rose images available in JPEG format.  The Wind 
Rose data includes the annual frequency, mean speed (percent), and percent of total wind energy 
from each of 16 directions (starting due north clockwise).  In order to view the related images for a 
given point, the Hyperlink tool must be used (see ‘Main Toolbar Functions’ below).  

• Main Wind Distribution:  This layer contains geographic information and average annual wind 
resource values for each 40,000 square meter grid cell.  The layer becomes visible at a scale of 
1:50,000 or greater. 

• City 
• State Boundary 
• County Boundary 
• Highway 
• Railroad 
• Urban Area 
• Federal Land 



 
• State / Local Park 
• River 
• Water Body 
• Surface Roughness: This layer is in grid format and cannot be displayed in conjunction with the 

wind maps. 
• Topography:  This layer is in grid format and cannot be displayed in conjunction with the wind 

maps. 
• The following layers include a portion of the wind resource database, and are displayed in a grid 

(raster) format.  Only one of these layers can be viewed at a time. 
� Annual Mean Wind Speed (30m, 50m, 70m, and 100m) 
� Annual Mean Power Density (50m) 

• State Background 
 
At any point you may zoom to the extent of a given layer by right clicking on that layer and choosing ‘Zoom to 
Layer Extent’.  Using View  >> Bookmarks in the main menu, you may zoom to the original “Full View” of 
your area at any time.   
 
Main Toolbar Functions: 
 

•   Zoom in by clicking a point or dragging a box around an area of interest  

•   Zoom out by clicking a point or dragging a box around an area of interest 

•   Zoom in on the center of the map by a factor of two with a single click 

•   Zoom out on the center of the map by a factor of two with a single click 

•   Pan (move) around the map by clicking on it and dragging in any direction 

•   Zoom to the full extent of all layers in the Table of Contents by a single click 
•   Zoom to the previous extent/Zoom to the next extent by a single click 

•   Identify related information about a feature by clicking on the tool and then clicking on that 
feature in the Map Window.  When you first identify an object the program will automatically default to 
identifying information from the top most VISIBLE layer.  If you wish to identify attributes from 
another layer you can then choose that layer from the drop down menu under ‘Identify from’ in the 
information box.  To view data from each layer by a single click, choose the ‘All Layers’ dropdown 
option. 

 
When using the identify tool the coordinates of the feature or feature part that is being queried are 
displayed in the identify box in a box titled ‘Location’.  The default coordinates are the units of the map 
projection, these units can be changed by clicking on the small box above the upper right corner of the 
‘Location’ box as shown below. 
 

  
 

 
         
 
 



 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
         
 
 
 
 
        

•         Measure distances between features on your map.  Once you select the tool you can single click on 
the first feature then single click either at another point, or along a path you wish to measure.  Double 
click to end you measurement.  The distance will be displayed in the bottom left corner of the window.  
The unit measurement is in meters since the data projection is in UTM, meters coordinate system. 

•   Hyperlink from a Wind Rose point to the Wind Rose Image by clicking on the tool and clicking 
on one of the blue points in the map.  This tool will automatically open the outside data for you to view.  
By simply holding the hyperlink button over the point, the program will display the file name of the 
Wind Rose image. 

 
Layout View Toolbar: 
 
Note that when you are in the Layout View, there are several tools available to the right of the scale text bar.  
Many of these buttons have similar symbols (magnifying glass, hand, etc) and are alike in function to the main 
tools mentioned above. However, the main tools will alter the appearance of the map in your layout whereas 
the layout tools will not.  The layout tools will only allow you to move around the layout - they will not change 
the scale of the map.   
 
Two additional layout tools are: 

•   Zoom to the full extent of the layout 

•   Zoom to the actual print size of you document 
 
Copying and Printing Maps 
 
Once you have selected an area of interest, you can copy the map to the Windows clipboard by selecting Copy 
Map from the Edit Menu.  To print the image in your Map Window simply choose Print from the main menu, 
or click on the Print icon.  You may also print from the Data View in absence of the other map elements by 



 
clicking on the globe and then choosing print.  Your Page Setup may also be adjusted under the main File 
menu. 
 
For More Information 
 
If you have any questions about the ArcReader program, please see the documentation under the Help menu, 
view the information on the ArcReader Installation disk, visit 
http://www.esri.com/software/arcgis/arcreader/index.html, or contact sclark@awstruewind.com. 
 
For help with information about the database or any other aspects of the wind maps, contact 
mbrower@awstruewind.com. 
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